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Introduction 

Overview 
MS Workstation software controls the 325-MS, associated Varian 
chromatography modules and several modules from other vendors. Information 
in this manual is also on the Help menu. 

Additional Manuals 

325-MS LC/MS Hardware Manual 

This manual, part number 9300017200, provides information for using, 
maintaining, and repairing the 325-MS. This information is also available in Help.  

MS Workstation Software Reference Manual 

This Manual, part number 391496300, explains the operation of the MS 
Workstation Software. These operations include displaying and reviewing 
chromatographic and mass spectral data, library searching, and quantitative 
analysis. Although these tutorials use Saturn 2000 ion trap files, they illustrate 
the principles of MS Workstation software.  

MS Data Handling Users Guide 

This Manual, part number 395403800, provides post acquisition data handling 
procedures and tasks. These procedures include identifying internal standards, 
adjusting integration parameters, identifying target peaks, and generating 
calibration curves. 
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Workstation Toolbar 

Overview 
The MS Workstation Toolbar has the following applications: Methods, Data Files, 
SampleLists, RecalcLists, SequenceLists, and Reports. Installing additional MS 
Workstation options, such as Star Finder and Star Custom Report Writer, may 
add other application buttons to the Workstation Toolbar. The following is a brief 
introduction to the applications. Later sections explain each in detail. 

As the cursor moves over a button, the name of the application appears below 
the cursor. Click an icon to launch the application. 

  

Name of Application 
Large 
Icons 

Description 

System Control/ 
Automation  

Monitor instrument status, and perform automated injections and batch 
recalculations. 

View/Edit Methods 
 

View and edit instrument operation, data acquisition, and data handling 
methods. 

Edit Automation 
Files  

Do off-line editing of SampleLists, RecalcLists, and SequenceLists. 

Review/Process MS 
Data  

Review chromatograms and spectra; perform library searches, and review and 
process quantitation results. 

Standard MS 
Reports  

Create, edit, and view standard MS reports. 

Custom MS Reports 
 

Create, edit, and view customized MS reports. 

Security 
Administration  

Set MS Workstation security options and passwords. 

SMS/MS File 
Conversion  

Convert data files between DOS and Windows formats. 

Batch Reporting 
 

Generate standard reports for a group of Data Files by dragging and dropping 
them on the Batch Report Window. 

View/Edit 
Chromatograms  

Review GC chromatograms, edit data handling parameters, and recalculate 
results. 

Standard Chrom 
Reports  

Preview standard chromatogram and results reports. 

Compound Set 
Editor  

Create and edit sets of compounds in the MS Data Handling Method allowing 
activation or deactivation under automation. 
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Quick Start 
 

Run a sample without using a Sample List. 

Quick Link Buttons 

The QuickLink buttons are on the right of the application icons. They correspond 
to most recently used Data Files and Methods.  

 

Most Recently Used Data File: Display options for the Most Recently Used 
Data File or select a different data file from the list of most recently used files. 

 

Most Recently Used Method: Display operations that can be performed on the 
Most Recently Used Method or a different method file selected from the list of 
most recently used method. 

 



 

6 

Workstation Toolbar Options 
 

Moving the Workstation Toolbar 

Move the Workstation Toolbar to any edge of the Windows screen. Click an area 
of the Workstation Toolbar that does not contain Application or QuickLink buttons 
and drag the toolbar to the preferred edge of the screen. The next time you open 
Workstation the toolbar will be at that spot.  

Workstation Toolbar Menu 

Put the cursor over an area of the Workstation Toolbar without an application or 
QuickLink button, and right-click to display the menu. 

 

Move to Windows Taskbar 

Display the Workstation Toolbar as a Windows Taskbar icon.  

Click Move to Windows Taskbar from the Workstation Toolbar options menu 
and the Taskbar icons appear in the lower right of the Windows Taskbar. Click 
the Workstation Toolbar icon to display the options menu. 

Show/Hide Applications on Toolbar 

Select the applications for the Workstation Toolbar. The left side lists the 
applications shown on the toolbar and the right side list the applications that are 
installed but not shown on the toolbar.  

 To remove an icon from the toolbar, select it from the top list and, then 
click Remove. 

 To add an icon to the toolbar, select it from the bottom list, and then click 
Add. 
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Enable/Disable Instrument Modules 

Enable instrument modules. When an instrument module is available, it appears 

in System Control. If the corresponding instrument is connected and on, you can 

create a Method section and format reports. The list on the left shows the 

instrument modules that are currently installed and enabled. The list on the right 

shows the instrument modules that are installed but not enabled.  

 To disable an instrument module, select it from the list on the left, and 
then click Disable. 

 To enable an instrument module, select it from the list on the right, and 
then click Enable. 

  

Application Descriptions 

When checked, a description of an application is displayed when the cursor 
moves over the icons. 
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Small Toolbar Buttons 

When Small Toolbar Buttons is enabled, a smaller version of the Toolbar opens. 
Notice that the graphics for some icons are slightly different. 

 

Run Application 

List the applications in the Workstation Toolbar. Click to open an application. 

Help on 

Select an item from this list to display the online help. 

Pick Data File for QuickLink  

List of the eight most recently used data files in order of use. Select a data file, to 
display it in the QuickLink button. 

Pick Method for QuickLink  

List of the eight most recently used Methods in order of use. Select one to 
display it in the QuickLink button. 

Help on Workstation Toolbar 

Displays help for the open application. 

Product Support Web Site 

If you have Internet access and a web browser installed on your computer, click 
to open the MS Workstation Product Support Web Site. It has the latest software 
and documentation updates for the MS Workstation suite of products, and notes, 
tips, and answers to frequently asked questions. Visit this site periodically for 
new information. 
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About Workstation  

About has information about the MS Workstation software version, installation 
history, and a list of the instrument modules installed. The following is an 
example; your software release may be different. 

 

Validate Installed Files: Uses checksums to test and document errors. Print a 
report documenting the file system tested, the results, the date printed and 
tested, and the ID of the person logged in (if login IDs are used). You can include 
a signature line. For more details, refer to online help. The following is an 
example 

 

Quit 

Close the Workstation Toolbar.  
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System Control 

Overview 
This section is an overview of System Control. Other functions are explained in 
detail in later sections. 

Double-click anywhere on the Configuration screen to view the Instrument Status 
and Control window. 
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Instrument Window 
Use the instrument window to monitor the status of the modules assigned to the 
instrument, monitor data acquisition, inject one or more samples, and do batch 
recalculations. From the top of the window, these features are System Control 
Menu, System Control Toolbar, Quad Status window, and various displays.  

 
 

File Menu 

 

Activate Method: Select an existing method to set the conditions for the 
connected modules such as the LC, MS, autosampler, and data handling.  

Upload Active Method from Modules: Save conditions from the existing 
modules in a new or existing method. This method becomes the active method.  

New SampleList: Create a SampleList.  
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Open SampleList: Open an existing SampleList. 

 

New RecalcList: Create a recalculation list. 

Open RecalcList: Select an existing recalculation list.  

NOTE: Process a RecalcList in System Control or in MS Data Review. In MS 
Data Review, from the Quantitation menu, select Process/Review RecalcList. 
Although Processing a RecalcList takes longer from System Control, you can use 
AutoLink functions including automated reporting with templates such as 
EnviroPro, ToxProPlus, and Multicompound Reports. 

New SequenceList: Create a sequence list.  

Open SequenceList: Select an existing sequence list.  

 

Print and Printer Setup are described in the MS Workstation Software 
Reference Manual. 
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Edit Menu 

Edit Module Info 

Click Edit and select Edit Module Info. 

 

Each module has a message log and a documentation screen. Use the Module 
Information Editor to record performance, maintenance, hours used, or other 
comments. 

 

Use Add, Edit, and Delete to record comments.  

Inject Single Sample Menu 

Use Inject Single Sample to enter sample information before making an 
injection. The Module window must be in acquisition mode before making an 
injection.  

 

Click Inject in the bottom left corner to begin either a manual or an autosampler 
injection. 
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Select a Sample Type from the list: 

 

Click Injection Notes to enter a description or comment. 

 

Use AutoLink to enter commands and parameters. Enter a command to execute 
a program after the data file is acquired. 

For more information about other fields, see the “SampleList and RecalcList 
Fields” Section in the MS Data Handling User’s Guide, part number 3954038. 

For example, you can activate a custom MS Report to print the sample reports.  

To run a Custom MS Report in automation: 

1. Type the directory path and the name of the Custom MS Report template (for 
example C:\VarianWS\EPA525.swt). Note that Custom MS Reports 
templates should always be stored in the VarianWS directory. 

2. Click Browse to select the command executable file. 

3. Click OK entering a selection.  

 

Automation Menu 

The following shows the Automation menu and describes the options. 
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Begin SampleList: Automation begins at line 1 and ends at the last line. 
Open SampleLists from the File menu. 

Begin Sequence: Begin an open SequenceList. You can change methods and 
SampleLists during an automated run.  
Open the Sequence from the File menu. 

Begin At: Start automation at a particular sequence or SampleList line and run 
until the last line is completed. A SampleList or SequenceList must be open to 
use this feature. 

Suspend Automation: Stop automation after the last completed sample. 

Resume Automation: Start automation after it was suspended. Automation 
starts from where it was suspended. 

Stop Automation: Stop automation immediately and reset all modules. 

Reset Modules: Bring the various modules to their ready states. 

Enable Automated Printing: Allow printer functions to work during automation. 

Recalculate Menu 

The following shows the Automation menu and describes the options. 

 

Begin RecalcList: Start an automated Recalculation. A Recalculation list must 
be opened under the File menu.  

Begin at Selected RecalcList Line: Process a Recalculation list starting with a 
chosen line and proceeding with the rest of the list. 

View Calibration Curves: View curves for the calibrated compounds in the 
active method. The Calibration Curve is saved as part of the Method.  

NOTE: Recalculations can be done in System Control or in MS Data Review. 
From the command Quantitation, select Process/Review Recalc List. Processing 
a Recalc List takes more time when done from System Control than in MS Data 
Review but has the advantage of allowing AutoLink functions such as automated 
reporting with Custom MS Reports templates such as ToxProPlus or EnviroPro. 
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Instrument Menu 

The following shows the Instrument menu and describes the options. 

 

Varian LC/MS: The configured instrument. Enter the information in Instrument 
Parameters in the Configuration screen. 

Configuration: Add new modules to the existing instrument.  

Remove Module Names: Remove associations between Module Names and 
Module Addresses. This lets you connect a Module with a different Module Name 
at that address. The next time the associated Module connects at that address, 
you are prompted to select the correct name for the Module. 
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Instrument 1 Faults: View faults in a module of Instrument 1. Click Update to 
check for new faults.  

 

Setup Ethernet Communication: Set up communication between the 212-LC, 
or other Ethernet modules, and System Control.  

Setup COMM Ports: Set up communication between System Control and 212-
LC, 460-LC, or CombiPal modules that communicate with the Workstation 
through the Serial ports on the PC. The first time you start System Control, the 
Star Communication Configuration Wizard starts automatically.  

Windows Menu 

 

Show Module Windows: Display the configured module windows. In this 
example, the modules are the 212-LC Pumps, the P460-LC, and the Quad. 

Iconize Module Windows: Create icons of individual module windows at the 
bottom of the screen. 

Show Automation Windows: View the open automation screens. The 
possibilities are SampleList, RecalcList, and SequenceList. 

Iconize Automation Windows: Create an icon of any open automation screen 
windows to access windows behind the automation windows. 

Arrange Icons: Arrange existing icons in a row at the bottom of the System 
Control window. 
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SequenceList: Display the active SequenceList. 

SampleList: Display the active SampleList. 

RecalcList: Display the active RecalcList. 

Instrument 1 Status: View the status of the modules connected to the system. 

Message Log: View the event log for the MS module. The log error messages 
for all configured modules. 

  

The last section of the Windows menu displays the attached modules and their 
status: 

 460-LC.01-Ready-DoorClosed 

 Quad.42: Not Ready 

Help Menu 

The Help menu has the following options. Click Help to open the Help window. 
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Help Topics 

To find help on a topic, do one of the following: 

 Click an item in Contents to open online help. 

 

 Click the Index tab and enter the first few letters of a word. Click the 
desired selection and click Display.  
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 Enter a key word or phrase to list help topics. Click a topic and then click 
Display. 

 

About System Control 

About has information about the software version, installation information, and a 
list of the instrument modules installed. About System Control opens the same 
window as About Workstation Toolbar does. The following is an example. 

 

Validate Installed Files:  Uses checksums to test and document errors. Print a 
report documenting the file system tested, the success, or failure of the test, the 
date printed and tested, the ID of the person logged in (if login IDs are used). 
You can include a signature line. For more details, refer to online help. See 
“About Workstation” on page 9. 
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System Control Toolbar 

The system control toolbar is near the top of the screen.  

 
 

The following describes the functions. 

 

Item Description 

 
Create a new automation file. 

 
First button: open an existing automation file. 

 
Second button: open the Message Log file. 

 
View/edit or print a Method. 

 
Open a Method. 

 
Edit notes for an automation file. 

 
Edit Module information for any online Module. 

 
Open Instrument 1 Status 

 
Inject a single sample.  

 
Start an open RecalcList. 

 
Start an open SampleList. 

 
Start an open SequenceList 

 
Suspend a running list. 

 
Begin a list. 

 
Stop a running list. 
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Quad Status and Control Window 
Check the status of the instrument components, monitor data acquisition, and 
process data using the Quad Status and Control window. Create your preferred 
window configuration. 

 
 

Quadrupole Module Menu 

File: Open or print a file. 

Method: Edit the current, active Method using Method Builder. 

Configuration: Synchronization signal settings and MS Options settings. 

 

 

Sync Signal: Enable or disable the Start and Ready signals for external devices. 
To enable a Sync Signal operation, connect a cable from the device to the 
contact closure on the master instrument. 

 Click Wiring to view a wiring diagram. 

 Select the Enabled check box to activate the desired function.  
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MS Options: Hardware diagnostic tool. View and edit MS Options, and the 
current software settings.  

 Check marks () indicate a Hardware match  

 X indicates a Hardware conflict. If an X is present, call your 
Varian representative. 

 
 

Tools: Access MS Tools such as MS/MS Breakdown, Pml Editor, Plot tic, 
readbacks, Bakeout system, and Overnight Standby. 

  

Quit Macros: Stop any MS function in progress. 
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User PML: Enter up to 10 PMLs (macros written in Paw Macro Language). 

 

Run a PML by clicking the corresponding smiley face in the toolbar. 

 

Plot tic, readbacks: Plot a graph of the following: the TIC, the area of 2 masses, 
2 readbacks, or a PML to monitor instrument status. Select the In use check box 
and the check box next to the desired parameter, and then click Apply. 

 

Analog output: For service use only. 

MSMS Breakdown: Optimize the collision energy for any given parent mass.  

Bakeout System: Not recommended for the 325-MS 

Overnight Standby: Turn off all gases and sets the MS to a low scan mass. 

 

Troubleshooting: Run various troubleshooting procedures. See the hardware 
manual for more information. 
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Inst setup/others: Perform initial instrument setup operations. 

 Coarse tune: Service use only 

 Calibrate pressures: Calibrates the MS EFC/EPC pressures. 

Reports: Select a print view setup. 

Help: Online Help and the About window.  

Quadrupole Toolbar 

 

 

 Choose File to Display: Open and display data files, and edit headers. 

 Start Collecting Data: Acquire data from only the MS and not other 
configured modules. Collect data using the current instrument conditions. Ensure 
that the source and detector are on before you use this feature. 

 

 Print: Print the window screen.  

 Turn Detector On and Off: Control electron multiplier. The color of the icon 
indicates the following: 

 Gray: Off 

 Green: On 

 Yellow: System in process of turning on or is waiting, for example, a 
filament delay time. If it turns yellow and then turns gray, a fail-safe has 
prevented the filament and the multiplier from turning on. 

 Set Instrument Parameters: Set ion source and analyzer parameters, and 
trip points to protect the electronics and vacuum shut off. Tabbed views reflect 
either the configuration. 
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API Source: Select API on-off sequence, N2 filling time, and Gas pressure 
readbacks. Select Nebulizing gas type, and set the API Housing, Drying, and 
Vaporizer gas temperatures. For normal operation mode, the API on-off 
sequence is set to Automatic. 

 

Analyzer: Vent the system and set the manifold temperature. Turn the CID gas 
on and off, set the electron multiplier (detector) voltage, and turn the Extended 
Dynamic Range on or off. 
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Safety: There are three sections and only Varian Representatives can change 
them.  

 High voltage enable and Ion Gauge modes 

 Trip points of the source pressure, manifold pressure and turbo speed 

 Status of the PCB Protect Switch 

 

Refer to the Hardware manual for more information about the setting up the 
Syringe pump. 
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 Define Scan Method: Set currently active scan parameters for Q1 and Q3, 
acquisition of centroid or profile data, and detection of positive or negative ions. 
Refer to Acquisition Method Window for more information. 

 

 AutoTune: Automatically tunes lenses, Q1 and Q3, and calibrates the mass 
scale. For information on the AutoTune process, refer to Autotune Functions and 
Options.  
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325-MS Module Views 

 

 

The five default views are: 

View I: Displays Quad Instrument status, Profile, Centroid, and Readbacks 
windows.  

View II: Displays Quad Instrument status, Chromatogram, Spectra, and Centroid 
windows.  

View III: Displays Quad Instrument status, Chromatogram, Spectra, and Profile 
windows.  

View IV: Displays Quad Instrument status, Chromatogram, Spectra, and Library 
windows.  

View V: Displays Quad Instrument status, Chromatogram, List, and Picture 
windows. 
 

 Select Views: Edit the five preset views. Select and display Views in the 
Quad window, shuffle them between different arrangements, and save them as I, 
II, III, IV, or V. Reset the settings with the Default button.  

 

Profile: Real time plot of the digital signal acquired over the mass ranges 
scanned (profile data). 

Spectra: Display acquisition of either profile or centroid spectra from the 
chromatograms. 

List: Program for temporary storage of lists of numbers for manipulation or 
statistical analysis by Paw macro commands. 

Centroid: Real time bar graph display of the mass peaks (centroid) of the digital 
signal acquired over the mass ranges scanned. 

Chromatogram: Real time or post acquisition display of chromatograms. 

Picture: Display program for graphing and drawing using Paw macro commands. 

Instrument Status: Graphic of the analyzer, with temperatures and pressures. 
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Readbacks: Real time text display of either analog or digital parameters. 
Readbacks are a valuable resource for fast diagnostics and include voltages, 
temperatures, pressures, and analog and digital signal values. Monitor 
Readbacks are plotted in the Pict view, as a function of time other variables. You 
can include Readbacks a trace in a data file. Readbacks are updated about once 
every second.  

Caution: Readback values are updated once every second whereas the RF and 
some DC voltages vary significantly faster during scanning or during pos/neg 
switching. As a result, the only meaningful readback values of these fast varying 
parameters are obtained when the scan is zoomed in on one mass and when 
there is no polarity switching.  

Probe: GC/MS only and therefore not an option for the 325-MS. Real time text 
and plot display of either the DIP or DEP probe. 

 



 

31 

AutoTune  

NOTE: The Hardware manual has a detailed description of AutoTune. 

Overview 
AutoTune optimizes the sensitivity, resolution, and mass calibration of the 
instrument.  

A reference compound, such as polypropylene glycol (PPG) is used as a tuning 
solution. A custom tuning solution can also be used. 

Autotune Examples 
Each quadrupole can be tuned in both polarities (positive and negative). A report 
with a display of the peak shapes and intensities and a text report with tuning 
details is displayed and saved to c:\varianws\methods directory. See the 
following. 
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The following is a sample of the tune report. 

 
 

Tune Stability 
For optimum tune stability, the temperature of the mass analyzer must be stable 
and at the set point temperature of the manifold before you start AutoTune. This 
may take several hours if the instrument has not been under vacuum for a long 
time.  

The tuning compound signal must be stable before starting AutoTune (Cal Gas 
on for at least 10 minutes, or PPG signal stable).  

NOTE: It is not necessary to tune the instrument daily. If there is a significant loss 
of signal, the ion source maybe contaminated. Clean the ion source and 
AutoTune. 

Tune the instrument after cleaning the ion source. This optimizes the instrument 
and ensures that the instrument is operating properly. 
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AutoTune Options 

Click AutoTune  on the Quad toolbar. Select the Analyzer and Polarity to 
tune and/or calibrate. 

 

Tune and Calibrate: Complete optimization of the mass analyzer for sensitivity, 
resolution, and mass calibration. Set the mass resolution with a peak width of 
0.7 amu at half peak height.  

A report is generated with a graphic of the peak shapes and intensities (saved 
with mode name and date) and a text report with detailed mass accuracy and 
mass abundance. 

Calibrate: Update the loaded tune file by re-tuning mass resolution and re-
calibrating the mass. No changes are made to settings in the ion source or the 
non-analyzing quadrupole. A new file name and report are created and saved. 

Report: Create and save a tune report. Compare with previous reports to 
determine if re-tuning is required. Creating a report does not change the tune file. 

Tune to Target Ratios: Only for a GC/MS in EI mode. 

Calibrate Detector (EDR): Optimize and calibrate the detector voltages over the 
entire dynamic range. Run this routine periodically and after replacing the 
detector. 

The detector calibration routine has two parts.  

 The first determines the optimal detector voltage for the maximum gain 
(EDR Maximum).  

 The second calibrates the detector gain as a function of voltage for a 
series of gain increments. This is used to run the detector in the 
automatic detector adjustment mode, or Extended Dynamic Range 
(EDR). EDR automatically adjusts the detector voltage to accommodate 
either small or large ion signals over the entire dynamic range of the 
mass spectrometer.  

The following shows detector gain as a function of detector voltage. 
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Stop Tuning: Abort the Tuning procedures and restore the most recent Tune file. 

Analyzer: Tune each quad individually or tune both. Use the default (Both) 
setting for triple quadrupole instruments. If using a triple quadrupole as a single 
quadrupole, select the quadrupole in use. 

Polarity: Set AutoTune polarity mode. vESI: AutoTune either positive or negative 
(APCI uses vESI tune file) 

Ion(s): Select either a specific ion or all defined ions in the Compound list. If 
choosing Single from the list, select an ion from a list of ions in the Standard 
compound. Using a single ion adds a new data point to the loaded tune file and 
does not change existing points. If the same mass is present, it is tuned and 
changed accordingly. A report for the single mass is created and the tune file is 
named and saved. 

Edit Standard Compound(s): Open Compound Editor and Modify a Standard 
compound or create a list of new compounds. 

Standard Compound(s): List the Standard compounds available. 

Cancel: Close AutoTune without executing a function. 

Tune File Naming Conventions: AutoTune automatically names and saves 
each newly created tune file using the following format. 

Compound Name/Mode (Date created).dac 

If a file by that name already exists the file name increments. 

First file: ppg (tuned on 27 Oct 2009 (quad 1: pos) .dac 
Second file: ppg (tuned on 27 Oct 2009 (quad 3: pos) .dac 
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Standard Compound Editor 
1. In the AutoTune window, select ppg from the Standard Compound(s) list. 

2. Click Edit Standard Compound(s) to open the following. 

 

Set Capillary: For standard compounds that you create, if the box is checked, 
set the capillary voltage for each ion to the value in Capillary (volts) field. If not 
checked or blank, the voltage from the capillary tune table is used. 

Capillary (Volts): If the Set Capillary box is checked, set the capillary voltage for 
each tune ion, otherwise this option is not available. 

If tuning with PPG, select Set Capillary and use the default capillary voltage 
values. 
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Method Builder 

Using Method Builder 
Click Method Builder in the MS WorkStation Toolbar. 

 

 

Edit an Existing Method 

1. Click Open an Existing Method File and then click OK. 

 

2. Select the method by doing one of the following: 

 Select the folder and then the file name. 
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 Click Recent Files to display them and select one. 

 

Build a New Method  

1. Click Create a New Method File and click OK to open the Method 
Builder Wizard. 

  

2. Select Instrument 1. The configured instrument is added to the method.  

3. Click Next. 
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4. Select a detector. After the data is acquired, you can add data 
processing information to the method. 

5. Click Next. 

 

6. Create sections for post-run processing. Add MS Data Handling to enter 
integration, peak names, and other parameters. Add Standard MS 
Reports to use the standard reports. 

7. Click Next. 

 

8. Review the information on the Confirm configuration screen. 

9. Click Next. 
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10. Review the configuration:  

 Click Back to make changes. 

 Click Finish to confirm. 

 

11. The new method is displayed with a navigation tree on the left side and 
the method workspace on the right. Click a tree entry to open that 
method section.  

  

 

  



 

40 

Add a Varian Instrument to a Method 

1. Select Create a New Method File and click OK. 

 

2. Click Custom and then click Next. 

 

3. Select an available module from the list and click Add to make it one of the 
Configured Modules. Other options are Add, Add All, or Remove. 

4. Click Next. 

 
 

5. Continue with step 3 of “Build a New Method” on page 37. 
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Acquisition Method  
Click Acquisition Method in the Method Builder tree. 

 

Set scan segments and define MS experiments. The Mass List has a toolbar that 
makes completing the table like using a spreadsheet.  

 

Method Specifications  

The following describe the Method Specifications in the Acquisition Method. 

Model 

Select your instrument Model. 
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Ionization 

Select the ionization mode:  Vortex Electrospray Ionization (vESI), or 
Atmospheric Pressure Chemical Ionization (APCI), Nano Electrospray Ionization 
(nESI), or Electrospray Ionization (ESI). 

 

Method Run Time 

There are two selections: 

 Select Use run time to use the run time in the method. 

 Type in the minutes to use a time other that in the method. If you do not 
enter a run time, the data is acquired until the end time is reached in all 
other modules. 

 

Data Type  

Set the scan type (Centroid or Profile).  

NOTE: Quantitation can be done in ether Profile or Centroid mode. 

 

  

Collect Delay 

This feature is useful for applications that have an initial clean up step.  

To delay data collection after the run starts, do the following: 

1. Check Use delay. 

2. Enter a time in minutes. The delay time begins when the run starts. 

 

Display File in Chro 

Enable to display data files in the Chro view. 
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Detector 

 Use EDR: (Extended dynamic range) the detector automatically adjusts 
the detector voltage over the dynamic range. EDR is calibrated during 
AutoTune.  

 EDR Maximum: Use the optimum fixed voltage for maximum gain from 
the last EDR calibration (useful for low-intensity MS/MS experiments). 

 Fixed Voltage: Enter a fixed voltage for the entire method or different 
ones for each segment using Advanced Options.  

 The detector can be programmed to turn off when the method ends. 

 

Scan Width 

Set the scan window for an ion in single ion monitoring. The default value is 0.70. 
Increase this value to match the resolution on the scanning quad, see Peak 
Width. For example, if the resolution is 3.0 on scanning quadrupole peak width, 
set the scan Width between 0.7 and 3.0 for the largest possible signal.  

 

 

Time Segment 

Use the arrows to select time segments. Use Add seg to add a time segment 
and Remove seg to remove a time segment from the scan method. Start at 
Retention Time defines the retention time start for each segment.  

 

Scan Channel Validation 

Indicates if Scan Channel Validation is enabled or not. Also See MS Data Review 
General Preferences. 

Scan Channel Validation:  ensures that the scan channel specifications for all 
compounds are correct after you add or delete transitions in the acquisition 
method.  

 If you change segment acquisition times, scan channel validation 
automatically updates the compound retention times. 

 If you select a compound that specifies a deleted transition, a warning 
message opens. The missing transition is referred to as “255” in the 
compound table.  
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 If you process a compound table that specifies a missing transition, the 
following message is logged, “Invalid scan function Cannot Quantitate”. 

The following show the part of the Method Builder window with Scan Channel 
Validation Enabled. 

 

Scan Time 

Set the scan speed of the MS. The scan speed is the amount of time the 
analyzing quadrupole does the scan. For full scan or MS/MS scan experiments, 
set the scan time to 0.5 seconds. More data points are acquired with shorter 
Scan Times. Increasing the scan time increases the signal to noise ratio since 
the quadrupole spends more time on the particular ion. For SIM, SRM, and 
MRM, decreasing the scan time allows more transitions to be scanned across a 
chromatographic peak. 

 

Collision Cell Gas 

Enable turn the CID gas (such as Argon) on for MS/MS operations.  

 

Peak Width 

Set the resolution for Quadrupole 1 (Q1) or Quadrupole 3 (Q3). 

Calibrated: the value from the most recent AutoTune file is the default setting. It 
is appropriate for most applications (Scan, SIM).  

For SRM and MRM reactions in MS/MS mode, the peak width of Q1 can be 
increased while keeping Q3 calibrated or smaller. The signal increases by 
allowing Q1 to transmit a wider peak width while Q3 detects the product spectra 
in a narrower peak. Determine a balance between sensitivity and selectivity. 
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Mass List 

Enter the desired mass range (Full Scan), single masses (SIM), and precursor 
and product masses (MS/MS). 

Q3 is used for triple quadrupole instruments only. 

 

Ion Polarity 

Click the Ion Polarity entry to switch between positive or negative ion detection. 

  

Capillary  

Enter the absolute value of the Capillary volts for each ion in the scan method. 
Method Builder enters the correct sign. 

 

Collision Energy  

Determine the Collision Energy for each reaction and enter it in the Mass List. It 
defines collision energies in electron volts for specific MS/MS reactions used in 
the collision cell.  

 

Requested Dwell Time 

Specify the Requested dwell time of each scan channel. The shorter the dwell 
time the greater the number of data points for the transition. Specify either the 
scan time or the dwell time.  If there are multiple full scan ranges in a single 
method segment, they must all scan at the same rate; despite the requested 
dwell time. The software gives each mass range a dwell time according to the 
overall Scan Time and the relative sizes of each full scan range. 
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Mass List Toolbar 

Enter values in the Mass List in a similar manner as a spreadsheet. The options 
are Add, Insert, Delete, or Clear All lines; Cut, Copy, or Paste from a cell or a 
line. Other options are fill down a column, and fill down or increment the values in 
a column (FD and I). The Mass List can be copied to or from an Excel 
spreadsheet. 

 

Advanced Options 

Use Advanced Options to access parameters for other features. These vary by 
ionization mode, instrument, and the optional ion sources (APCI, ESI, and nESI). 
Use overrides when doing MS/MS breakdown curves. This provides a setpoint 
for the system to check. 

The advanced options available depend on the ionization mode. 

vESI: Overrides, Valve and Syringe Pump, Drying Gas, Vortex Gas, User 
Analogs In/Out, PMLs. 

APCI: Overrides, Valve and Syringe Pump, Drying Gas, Vaporizer Gas, User 
Analogs In/Out, PMLs. 

vESI Overrides 

Enter values to override those specified in the method for specific time segments. 
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APCI Overrides 

Enter values to override those specified in the method for specific time segments. 

 

User Analog In/Outs 

Use the Analog outputs to send a TIC signal to a device such as a LIMS system. 

Use the User Input Traces to acquire data from another detector such as an  
Evaporative Light Scattering Detector. 

 

PMLs (Paw Macro Language) 

MS Workstation provides PML macros you can use before or after a time 
segment. Modify and create PMLs through Tools in the Quad Module View. 
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Valve and Syringe Pump 

Use the six-port valve or the syringe pump or both. The six-port valve can be 

used in Manual, Diverter or Injector mode. Set the flow rate for the syringe pump.  

  

vESI and APCI Drying Gas Temperature Ramp 

Use the SelecTemp™ feature to ensure the optimum drying gas temperature for 
the mobile phase composition of vESI, APCI, or ESI runs. 

NOTE: If a multi-segment method with a temperature ramp is in progress and 
there is a segment with a temperature override, the temperature goes to the 
setpoint for that segment. The ramp continues after the segment is completed. 

 

vESI Vortex Gas Temperature Ramp 

Enter a vortex gas temperature program to ensure the optimum vortex 
temperature. 
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APCI Vaporizer Gas Temperature Ramp 

Enter a vaporizer gas temperature program to ensure the optimum vaporizer 
temperature. 

 

Schedule tMRM 

Use timed MRM transitions (tMRM™) transitions to automatically break up an 
acquisition method into multiple segments. Using many segments in an 
acquisition method allows for longer MRM dwell times and therefore increases 
the sensitivity. See theScheduling Timed MRM Transitions section on page 53 
for more information. 

 

Setting up MS and MS/MS Acquisitions 

Overview 

Please note that in the following figures the first two columns, CAS Number and 
Compound Number are omitted. 

MS Operations 

 Line 1: Single Ion Monitoring (SIM) of 250  

 Line 2: Full Scan from 100 to 300  

 

SIM 

Full 
 

MS/MS Operations  

 Line 1: Selected Reaction Monitoring (SRM) 

 Line 2: Precursor Scan 

 Line 3: Neutral Loss Scan 

 Line 4: Product Ion Scan 
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SRM 

Precursor 

Neutral Loss 

Product Ion 

 

MS Operations 

Full Scan Acquisition: Scan for all ions over a defined mass range. Enter the 
start and end masses. 

Example:   

 Line 1: EI Full Scan, from mass 130 to 280 

 

Single Ion Monitoring (SIM): Detect one or several ions. This mode is more 
sensitive than Full Scan.  

Example: 

 Line 1: Negative SIM 321 

 Line 2: Negative SIM 414 

 

Mixed Scan Operations: Acquire data in Full Scan and SIM mode at the same 
time. 

Example: 

 Line 1: Positive SIM 120 

 Line 2: Positive SIM 230 

 Line 3: Positive Full Scan from 200 to 400  
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Mixed Polarity Operations: Acquire data in positive and negative ion modes for 
vESI, APCI, or ESI.  

Example: 

 Line 1: Positive SIM 120 

 Line 2: Positive Scan from 200 to 400 

 Line 3: Negative SIM 230 

 Line 4: Negative SIM 290 

 

Multiple Time Windows: Several time windows (Segments) can be created for 
an acquisition. You can do any of the previous scan modes, or mixed scan 
modes in any time segment and select either positive or negative polarity. 

Scan Channel Validation: Enable or disable in MS Data Review as follows.  

1. From MS Data Review, click Preferences and then select General. 

2. Open the Validation tab, and select the Validate Scan Functions check box 
or click to clear it. 

 Enabled: If you change the time for the start at retention time 
value, validation will shift the retention times of all peaks 
proportionally.  

 Disabled: Changes you make will not be in sync.  

 

MS/MS Operations 

Product Ion Scan : Scan for fragments of a particular ion. The precursor ion is 
selected in Q1. In Q3 the start and end masses set the scan range for the 
product ions.  

Example: Precursor ion 219, Product scan 50 -250, and Collision energy of 5. 

 

Precursor Ion Scan: The precursor ions of a selected product ion are scanned. 
A start and end mass is set in Q1 and Q3 is set to the desired product ion. 

Example: Precursor scan 100-500, Product ion 195, and Collision energy of 10. 
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Neutral Loss Scan: Precursor ions are scanned in Q1. Q3 scans the same 
range minus the neutral loss mass. 

Example: For loss of m/z 18 (water); precursor scan 100-300, product scan 82-
282. Scan displays product ions resulting from the precursor ions losing a neutral 
mass of 18. 

 

Selected Reaction Monitoring (SRM): This process monitors one or more 
MS/MS transition(s) of a precursor ion fragmenting with a specific energy into a 
product ion. The example shows a single transition although more can be 
monitored. 

Example: Precursor ion 414, Product ion 219, and Collision energy -10. 

 

Multiple Reaction Monitoring (MRM): Multiple reaction monitoring is set up like 
selected reaction monitoring but allows many MS/MS transitions between Q1 and 
Q3 to be monitored. Set the Requested Dwell Time to allow for full monitoring. 

Example: 

Line 1: Positive SIM: Precursor 452, Product 225 

Line 2: Positive SIM: Precursor 525, Product 315 

Line 3: Positive SIM: Precursor 633, Product 380 
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Mixed Polarity MS/MS Operations: Acquisition of MRM in positive and negative 
ion mode.  

Example:  

Line 1: Positive SIM: Precursor 480, Product 225 

Line 2: Negative SIM: Precursor 612, Product 375 

Line 3: Positive SIM: Precursor 452, Product 225 

Line 4: Negative SIM: Precursor 688, Product 315 

 

Multiple Time Windows: Several time windows can be set within one 
acquisition. Each time window allows Full Scan, SIM, MS/MS, or mixed 
operations. The Request Dwell time can be set. 

Scan Channel Validation:  

Enable or disable in MS Data Review as follows.  

1. From MS Data Review, click Preferences and then select General. 

2. Open the Validation tab, and select the Validate Scan Functions check box 
or click to clear it. 

 Enabled: If you change the time for the start at retention time 
value, validation will shift the retention times of all peaks 
proportionally.  

 Disabled: Changes you make will not be in sync.  

 

Scheduling Timed MRM Transitions
 

Overview 

Use timed MRM transitions (tMRM™) transitions to automatically break up an 
acquisition method into multiple segments. The use of many segments in an 
acquisition method allows for longer MRM dwell times and therefore increases 
the sensitivity.  

Before you use tMRM, enable the Scan Channel Validation option in the 
Validation tab of the MS Data Review Preferences General dialog.  

You can schedule timed MRM transitions by filling in a blank template or by 
exporting the MRM data from an existing method. The following describes both: 

 To create timed MRM transitions from Method Builder or System Control:  
In Method Builder, select Acquisition Method, and then click 
Schedule tMRM to open the Schedule tMRM window.  
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 To create timed MRM transitions from the System Control Quad Module 
window:  
Click the Define Scan method icon. When the window opens, click the 
Schedule tMRM button in the lower left. 

The Schedule tMRM window has the following four areas: 

 Create a tMRM spreadsheet template:  
Create a tab-delimited *.txt file to use as a template in Microsoft Excel® 
to enter the tMRM transitions. 

 Export a Scan Method to a tMRM spreadsheet:  
Export an existing method (*.mth) to a tab-delimited *.txt file 

 Import MRMs to Scan Method:  
Import a text file (*.txt) with MRM data from Microsoft Excel into Method 
Builder. 

 MRM Import Statistics:  
Summary information about the last tMRM import action performed.  

NOTE: After a method is created with tMRM, make additional changes to the *.txt 
file and import it again with tMRM. 
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Click Help to open a window that outlines how to create a tMRM. 

 

NOTE: The spreadsheet must have the CAS Number, Compound Name and 
Last Mass columns. You do not need to enter values.  

Using tMRM with a New Method 

To create tMRM transitions in a blank template, complete the following two-part 
procedure. 

1. Create and complete a new spreadsheet template, using the Create a 
tMRM spreadsheet template area. 

2. Import the spreadsheet into a new method, using the Import MRMs to 
Scan Method area. 

Creating a tMRM spreadsheet template 

To define tMRM transitions in a new method do the following: 

1. Click Make template in the Create a tMRM spreadsheet template 
area. 

2. Enter a file name and click Save. A tab-delimited template file is saved in 
the VarianWS\methods folder. 

3. Open Excel®, and then open the file.  

4. Select Text Files in the Files of type field in the lower part of the Open 
window. 



 

56 

 

5. The spreadsheet has the following fields. The CAS Number, Compound 
Name, and the Last Mass columns are required. You do not have to put 
data in these three fields: the others fields must be completed. 

 CAS Number: A string containing the Chemical Abstract Services 
number for the compound. 

 Compound Name: A string describing the compound 

 Polarity: The polarity for acquisition method:  

o Use „+‟ or „-„ or 

o Use the number 0 for positive and 1 for negative. 

 Q1 First Mass: The mass for Q1, m/z. 

 Q1 Last Mass: Use this only if a mass range is to be filtered in Q1, 
m/z. 

 Q3 First Mass: The mass for Q3, m/z. 

 Q3 Last Mass: Used only if a mass range is to be passed in Q3, m/z. 

 Capillary: Volts. 

 Collision Energy: Volts. 

 Dwell Factor: Relative factor for setting dwell times. The default is 1.  

o Requested Dwell Time: the Dwell Time is multiplied by the 
Dwell Factor for each transition.  

o Requested Scan Time: the Dwell Time is based on the 
number of transitions in the segment and is multiplied by the 
Dwell Factor for each transition. The range is 0.006 to 14 
seconds. 

 Retention time: Minutes in decimal minutes. For example 1 minute 
and 30 seconds is 1.50 minutes. 

 RT Window: Retention Time Window in decimal minutes 

 

  



 

57 

6. Complete the spreadsheet with the information for your compounds 
using the MRM parameters in the MRM database or another source, 
such as an application note, commercial or personal database. Be sure 
to complete the required fields.  

7. Use the Save As command to save the spreadsheet with a new name. 
Keep the tab-delimited *.txt file format. 

Importing MRMs to Scan Method 

To import a completed MRMs spreadsheet to the scan method, do the following: 

1. From the Schedule tMRM window, click Browse in the Import MRMs to 
Scan Method area. The Import file name window opens. 

2. In the Import file name window, locate the spreadsheet, and then click 
Open. The file name appears in the Schedule tMRM window. 

3. Select Requested scan time or Requested dwell time, and enter the 
time in seconds. 

4. Enter the Minimum segment time width in minutes. This determines 
the shortest time width that tMRM uses to optimize the method. By using 
a smaller time width, tMRM breaks the method into more segments. 

5. Enter the Maximum number of segments. This is the maximum 
number of segments tMRM uses to optimize the method. The maximum 
value is 60. 

Creating tMRM transitions from an Existing Method 

If you have an existing method and want to make tMRM transitions, complete the 
following two-part procedure. 

1. To make a spreadsheet from an existing method and enter data to 
complete it, use the Exporting Scan Method to the MRM spreadsheet 
area. 

2. Import the spreadsheet into a new method using the Importing MRMs to 
Scan Method area. 
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Exporting a Scan Method to a tMRM spreadsheet 

1. From the Schedule tMRM window, click Browse in Export a Scan 
Method to a tMRM spreadsheet area. 

2. Enter the file name of the existing method with the MRMs transitions, 
and then click Open.  

3. Click Export to save the MRMs as a tab-delimited *.txt file in the 
VarianWS\methods directory. 

4. Open Excel®, and then open the file.  

5. Select Text Files in the Files of type field in the lower part of the Open 
window. 

 

6. The spreadsheet has the following fields. The CAS Number, Compound 
Name, and the Last Mass columns are required. You do not have to put 
data in these three fields: the others fields must be completed. 

 CAS Number: A string containing the Chemical Abstract Services 
number for the compound.  

 Compound Name: A string describing the compound name. 

 Polarity: The polarity for acquisition method:  

o Use „+‟ or „-„ or 

o Use the number 0 for positive and 1 for negative. 

 Q1 First Mass: The mass for Q1, m/z. 

 Q1 Last Mass: Use this only if a mass range is to be filtered in Q1, 
m/z. 

 Q3 First Mass: The mass for Q3, m/z. 

 Q3 Last Mass: Used only if a mass range is to be passed in Q3, m/z. 

 Capillary: Volts. 

 Collision Energy: Volts. 

 Dwell Factor: Relative factor for setting dwell times. The default is 1.  

o Requested Dwell Time: the Dwell Time is multiplied by the 
Dwell Factor for each transition.  

o Requested Scan Time: the Dwell Time is based on the 
number of transitions in the segment and is multiplied by the 
Dwell Factor for each transition. The range is 0.006 to 14 
seconds. 

 Retention time: Minutes in decimal minutes. 

 RT Window: Retention time window in decimal minutes 
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7. Complete the spreadsheet with the information for your compounds 
using the MRM parameters in the MRM database or another source, 
such as an application note, commercial or personal database. Be sure 
to complete the required fields.  

8. Click Save As, and then save the spreadsheet with a new name. 

Importing MRMs to Scan Method 

To import a completed tMRM spreadsheet to the Scan Method, do the following: 

1. From the Schedule tMRM window, click Browse in the Import MRMs to 
Scan Method area. 

2. In the Import file name window, locate the spreadsheet, and then click 
Open. 

3. Select either Requested scan time or Requested dwell time and enter 
the value in seconds. 

4. Enter the Minimum segment time width in minutes. This determines 
the shortest time width that tMRM uses to optimize the method. By using 
a smaller time width, tMRM breaks the method into more segments. 

5. Enter the Maximum number of segments. This is the maximum 
number of segments tMRM uses to optimize the method. The maximum 
acceptable value is 60.  

Statistics  

The Statistics area displays summary information about the most recent tMRM 
that was imported.  
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Injecting Samples 

This section explains doing a single manual injection and programming multiple 
injections using the autosampler 

To make a single injection, use Inject Single Sample.  

To program multiple injections, use SampleList. 

Overview 
Samples are injected using System Control. There are four steps in data 
acquisition: 

1. Create or modify an existing method. 

2. Set up a SampleList or enter sample information for a single sample. 

3. Prepare and load the samples on the autosampler. 

4. Start the run. 

Startup / Shutdown  
The startup and shutdown procedures and the injection methods are similar for 
vESI and APCI methods.  

Startup 

The instrument must be pumped down and running before you begin. 

1. Click Turn Spray On in the Quad View to turn on the gasses and heaters.  

2. After the Drying gas temperature reaches at least 75% of the set value, start 
the LC pumps.  

3. Wait a few minutes for the temperature to stabilize and click Analyzer 
On/Off to turn on the Detector. 

 Turn Analyzer On/Off 

Spray On/Off 
Collect Data 
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Shutdown 

1. Turn off the LC pumps. 

2. Allow the LC pump pressure to drop down and stabilize so the flow into the 
MS stops.  

3. Click the Spray icon to turn off the gasses and heaters. The Analyzer turns 
off automatically when you turn off the source. 

vESI: The gas stays on until the temperature drops below 250 C and then 
chamber cannot be removed until then. 

Syringe Pump and Valve 
Use the six port valve to divert flow away from MS, or to make injections. Set the 
flow of the syringe pump and have the pump shut off at the end of the method. 

The Hardware manual shows how to set up the syringe pump. 

1. Click Advanced Options and select the Valve and Syringe Pump tab. 

2. Select Manual, Diverter, or Injector for the valve. The system can turn the 
syringe pump off at the end of the run. 

3. Enable Use Syringe Pump, type in the flow rate, and enable the check box 
Turn off at end of method. 
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Manual Injections  
Use the manual injection mode to collect data from the MS. Methods are not run 
on the configured modules. 

Plumb the switching valve as shown. 

 

To do manual injections: 

1. Monitor the baseline using the Plot Tic tool in the Tools menu. 

2. After the baseline stabilizes, click the Traffic light and the Collect data file 
window opens.  

NOTE: The source and detector must be on to use the Traffic light to collect data. 

 

3. Click File naming methods to open the Automatic File Naming window. 

4. Click Auto-increment. Type in the name of the data file. 

5. Enter 1 for Sequence #, and 2 for digits.  

NOTE: Click Browse to review or select an existing file name that you may wish 
to use as a root for the file name of your sample. 
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6. Click OK and the Automatic File Naming window closes.  

 

7. Complete the Collect data window. 

8. Click Apply and if you are ready to collect data, click Start MS. 

9. Check that the valve is in the load position.  

10. Overfill the 5 µL switching valve loop with 3 or 4 times the volume. Push the 
button on the valve cover. Allow at least 1 minute between injections or click 
the valve icon in the Quad view. 

11. Stop data collection by opening the Collect data window and clicking Stop 
MS.  
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 Injecting Single Samples  
To do one injection, that uses the configured modules, do one of the following: 

 Click Inject Single Sample from the Inject menu  

 Click the Inject Singe Sample icon on the System Control menu bar.  

 

Inject Single Sample 

 

Clicking Inject Single Sample from the Inject menu opens the following window. 
The fields are dependent on the sampling device. For more information about 
these fields, see the “SampleList and RelcalcList Fields” section in the MS Data 
Handling User’s Guide, part number 3954038. 

  

Enter the Data File Name and Path 

Data File names can have up to 255 characters. They can be a combination of 
Sample ID, injection date, module name, and injection number.  

Click Data Files to open the Data Files Generation window. 

 

Select the drive letter and subdirectory (path) to store your files from the left side. 
The default directory is the data subdirectory of your VarianWS directory.  
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Create a filename format on the right side. You can combine a text entry with the 
“%” symbols to specify filenames with variable sample injection information. An 
example of the filename updates as you enter filename specification.  

Select a RecalcList 

You can store the files the SampleList creates in a RecalcList, which tracks the 
names of the created files and other parameters. You can reprocess the 
RecalcList later, for example, to reprint the reports or to process data with 
another method. 

Click RelcalcList to open the RelcalcList Generation window. You can create a 
new RecalcList, append to an existing RecalcList, overwrite the RecalcList, or not 
create or update a RecalcList.  

 

Click Overwrite the RecalcList each time the SampleList Begins to overwrite 
the RecalcList. 

Click Append to an existing RelcalcList, to append a number to the new 
RecalcList filename.  

QuickStart 

QuickStart injects a single sample without using System Control directly. 

Customize QuickStart to set up instruments for routine use. See online help for 
more information. 

QuickStart starts System Control and waits for all modules to log in before 
opening. 

 

Enter information in the MS QuickStart window about your injection. For more 
information about the fields, see the “SampleList and RelcalcList Fields” section 
in the MS Data Handling User’s Guide, part number 3954038. 
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Autosampler Display  

Each of the supported autosamplers has a graphic representation of the 
carrousel or tray. In System Control, click the autosampler icon in the Instrument 
Status Window to open it. Inject from a vial by double-clicking on the appropriate 
vial in the display. 

After the Inject Single Sample dialog opens, enter the information, and make the 
injection. 

 



 

67 

Running Priority Samples Using Inject Single Sample  

Use either the graphical vial selection or Inject Single Sample to make a priority 
injection during automated analyses. 

1. While automation is running, click Suspend on the current active SampleList. 
Automation is suspended after the current run is completed. 

2. Double-click the vial position of the priority sample or choose inject single 
sample.  

3. After completing the priority run, click Resume to re-start the SampleList. 

Autosamplers 
You can create SampleLists for different autosamplers, and use more than one 
method for your injections. 

SampleLists in System Control 

 To inject multiple samples from System Control, use a SampleList from 
the File menu or from System Control.  

 To create a new SampleList: On the File menu, click New SampleList or 
click Open SampleList to select an existing one. 

 For more information about the fields, see the “SampleList and 
RelcalcList Fields” section in the MS Data Handling User’s Guide, part 
number 954038. 

 

From the System Control toolbar, create a new SampleList or open an existing 
one  

 

New SampleList Open SampleList 
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Generic SampleList 

If you do not have a sampling device configured, a generic SampleList opens. 
This SampleList does not have fields for vial positions, sampling options or 
hardware configuration options. 

The SampleList fields are like spreadsheet columns and can be sized by 
dragging the border. Right-click a column header to display formatting options. 

 Enter Comments Select Post Run Events 

 

The Sample Name field remains fixed as you scroll to the right to help you enter 
information about your samples. 

You can enter data handling parameters, such as, the amount for single internal 
standard calculations, the unidentified peak factor, a multiplier, and a divisor. 

If your requirements are more complex (such as multiple internal standards or 
multiple detectors, which require different entries) use the MultiChannel 
MultiStandard field. 

Each autosampler has a unique SampleList. A SampleList can have more than 
one autosampler section so it can be used with different autosamplers.  

ProStar 420 and 430 SampleList 

The ProStar 420 and ProStar 430 SampleLists have generic System Control 
SampleList fields and fields for operations specific for each AutoSampler.  

To build a ProStar 420 SampleList or a ProStar 430 SampleList, click Add. 

 

You can enter information common for all samples. You can select the number of 
entries to be added sequentially to the SampleList. With the ProStar 420, you 
can specify the first and last vials to be added to the SampleList with the 
requirement that the first and last vial numbers start with the same Tray Type 
letter, A, B, C, or D.  
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With the ProStar 430, you can specify the first and last Row and Column to be 
added. You can also select to add by Rows or Columns, which determines if the 
plate is processed from left to right by row or from top to bottom by columns. 

Select Partial Loop fill, Full Loop, or µL Pickup from the Injection Mode field. 
Select the User Program from this field also. Several fields are disabled when 
User Program is selected. 

For the ProStar 430, use the Plate column to specify the plate that has the well or 
vial with the sample. Enter a plate number between 1 and 7. This field is disabled 
unless the ProStar 430 is equipped with the Plate Feeder option. 

The ProStar 430 Well/Vial field specifies the sample location as a combination of 
row letter and column number. The available rows and column numbers depend 
on the type of plate configured. 

 48 standard vials: A1 through F8 

 96 well plate: A1 through H12 

 384 well plate: A1 through P24 

Use the Well/Vial field to randomly access any well or vial. For example, you can 
periodically recalibrate from a single standard in a fixed location. 

For the ProStar 420, the Vial field specifies the sample vial as a combination of 
Tray type letter and Vial number. The available Tray types and Vial numbers 
depend on the Tray Segments configured. You can randomly access any vial. 

In the Wash Volume field enter a wash volume in the range of 300 to 9999 L, or 
enter 0 for no wash. 

In the Automix Routines field, define a specific automixing program to be done 
before the sample is injected. When doing an Automix routine, you can program 
the AutoSampler to aspirate liquid from a well, vial, or a reagent vial, and transfer 
it to the sample well or vial from which an injection is to be made.  

You can mix the sample by aspirating and dispensing specified amounts. 

You can program the AutoSampler to wait for a specific time interval. Use the 
Automix Steps dialog to select Action, Position, Amount, Speed of the syringe, 
and Height of the needle. The following is an example of an Automix routine. 
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A maximum of 240 steps can be programmed in one Automix routine. After 
entering all the steps, enter a name for this Automix Program in the box next to 
Cancel and click OK. The program is saved in the SampleList, and can be 
exported to other SampleLists. Alternatively, Automix Programs from other 
SampleLists can be imported to the active SampleList using Import. 

The User Program column is enabled if selected in the Injection Mode field for 
the sample. The User Program can do sample handling and injection actions. 

When the User Program is selected as the Injection Mode, the following fields 
are disabled; Injection Volume, Wash Volume and Automix Routines. The User 
Program steps are used instead of the method parameters. You must use the 
User Program if the 10mL syringe is selected. The following figure shows lists the 
User Program Actions. For each specified action, there could be several options 
such as Position, Amounts, Speed Setting, and Height. Start the run, by selecting 
Start run on the INJECT Marker or selecting Start run at End of User 
Program. 
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460-LC SampleList 

To create a 460-LC SampleList, do the following: 

1. Click the Edit Automation Files button to open the Automation File Editor. 

2. Click the New Automation File button and click new SampleList. 

3. Enter a file name and click Save. 

 
 

4. Select the 460-LC AutoSampler and click OK. 

 

5. An empty SampleList with your file name opens. 

 Click Add to add one sample. 

 

 Click Add Lines to add several samples or a plate. 
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 Click Hardware to specify the tray type for each position, sample 
loop volume and indicate if the Syringe for Prep Mode is installed. 

 

Sample Name: Enter the “root” name for all samples.  

Sample Type: Select Analysis, Calibration, Verification, or Baseline from the 
menu. 

 
 

Cal. Level: This numerical field is used with Calibration and Verification Sample 
Types.  

Inj. Enter the number of injections in this numerical field. 

Injection Notes: Enter a note about the sample or the injections in this text field. 
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AutoLink: Add a Command or Other parameters for post run event.  

 

Injection Mode: Select No Injection, Partial Loopfill, Full Loop, or µL Pickup 
from the menu. 

Inj. Volume: The 460-LC comes with a 100 µL sample loop. Injections can be 
made with 1 µL increments. 

Tray: Create a sample list for either the Left or Right tray. 

Vial/Well: Enter a combination of a row letter and a column number. The 
available rows and column numbers depend on the type of plate configured. 

 96 well plate: A1 through H12 

 384 well plate: A1 through P24 

Wash Volume: Enter 1 to 9 washes. 

Automix Routines: Use these routines only with the 84+3 Adapter Tray. 

Combi PAL SampleList 

HTS PAL for LC/MS has settings for Tray selection, Vial position, and Injection 
Volume.  

 

Default SampleList Entries 

When you add a new row to a SampleList, default values are entered. To change 
them, click Defaults and the appropriate SampleList Defaults dialog box opens. 
Enter the desired default values and click Save. 

Volume, rack, and vial number are not displayed, even if an AutoSampler is 
present. 
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Saving SampleLists for Later Use 

When you make changes to the open SampleList, the changes are automatically 
saved to the SampleList file and are used for the automated runs in progress. If 
you want to edit a SampleList other than the open SampleList, use the offline 
Automation File Editor application described in the next section of this manual. 

Using More Than One Method for Injections 

Perform automated injections using more than one Method. Either change the 
active Method in the SampleList or use a SequenceList. 

Changing the Method in the SampleList 

Change the Method by activating a Method in a SampleList row. 

 

 

Activate Method  AutoLink 

 
 

 

Select Method 

Enter Method Name 
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Using the SequenceList Window 

On the File menu, select a New SequenceList or Open SequenceList.  

 

 

In the SequenceList, select an Action. Enter the Method and the SampleList or 
click Browse to select from a list. 

 

Browse for a Method or SampleList 

Enter the Method and SampleList Select Action 
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Monitor Run Status  
After making an injection, monitor the run in System Control. The status and 
control window and the Toolbar display the module status. 

Message Log 

Automation actions and errors are recorded in the Message Log. The most 
recent entry is at the bottom. Double-click the status bar at the bottom of the 
instrument window to display the entire Message Log. The log is saved in the 
c:\VarianWS\MSGLOG directory. Each Message Log entry is stamped with the 
time and date. 

 
 

Automated MS Report Generation 
Add Report sections to your Methods to generate automated reports from 
System Control after each injection, after Recalculations, or by using Print 
actions in the Sequence window. When Automated Printing is enabled, a 
checkmark appears in the front of the Enable Automated Printing menu listing. 
To disable automated Report printing during an automated sequence of 
injections or Recalculations, click Enable Automated Printing from the 
Automation menu to disable it and remove the check mark. A SCII file is 
generated, if selected in the Report Method section. When you disable 
automated printing, automation continues but no reports are printed.  
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Stopping an Acquisition 
During automation and while the system is running you can suspend or stop data 
acquisition from the Automation menu in System Control. 

Suspend Automation: Suspend automation after the current run is completed. 

Stop Automation: Stop the current run, reset the modules, and suspends 
automation. 

Resume Automation: Resume automation after suspension.  

Reset Modules: Stop the current run, and reset all modules. Automation 
proceeds to the next injection after all the modules go to the Ready state. 

 

If the Acquisition was started from Start collecting data  in the window 
Toolbar, click Stop MS to end data acquisition or in the Automation Menu bar 
click Stop Automation. 
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Set a Collect Delay 
Use collect delay to start data acquisition after the sample is injected. A 
separation can be set up to remove buffer from the sample. The solvent or buffer 
can be diverted to waste and data collection can be started after the valve 
switches to bring the flow into the MS. In the first 30 seconds of a separation, 
data collection can be turned off while un-retained compounds that are not of 
interest are washed off the column. Data collection can start when the mobile 
phase composition changes and the sample begins to elute. 

LC/MS  

Use the 6 port valve to divert the LC effluent away from the API Source. 
Frequently, the solvent front contains un-retained non-volatile salts from the 
sample. If not diverted, these salts would deposit on the source and the source 
may require more frequent cleaning. The delay parameter switches the diverter 
valve to waste for a set time.  

While the flow is diverted from the source, you can delay data collection in the 
Acquisition Method. The syringe pump can be programmed to provide make up 
flow to the API while the LC effluent is diverted. 

Acquisition Method 

In Method Builder, open the Acquisition Method. Enabled: Use delay and enter 
the delay time in minutes. 
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MS/MS Breakdown  
The Breakdown Curve makes MS/MS method development easy. The sample is 
introduced into the mass spectrometer API source with a syringe pump. A 
precursor ion is selected for MS/MS breakdown curves.  

In the Sample Control window, the precursor ion can be viewed in the profile or 
centroid mode by entering SW xxx in the Ctrl text field (at the bottom left of the 
window0, where xxx is the desired mass.  

 

 

To create a Breakdown Curve, do the following: 

1. On the Tools menu, click MS/MS Breakdown. 

2. Select Q2 Collision Cell Breakdown, or API Capillary Breakdown. 

 

 

The Create a breakdown curve window opens. 

1. Enter the precursor ion in Parent mass.  

2. Click Turn on CID gas. Wait about a minute for it to stabilize. 

4. Select either Normal (0.5 V steps) or Fast (2V step) Collection speed. Either 
is adequate for most conditions.  

5. To save the data to a method, select Enable, select Save, choose the 
number of products to save. 

6. Click Browse to select the method in which to save the product ions with the 
highest intensities. 

7. Select Apply, and then Start. 



 

80 

 

The breakdown curves are displayed. 

To add additional ions to the method, repeat the process for the next precursor 
ion. For example, type SW 790 in the Ctrl line (or SW and whatever precursor ion 
you choose). 

For this additional precursor ion, select Auto find product masses or specify 
the product masses. 

To add ions and collision voltages to an existing method, select Append and the 
appropriate method. 

One option is to create a breakdown curve by scanning the API capillary. 

To create a breakdown curve by scanning the API capillary, do the following:  

1. Click Create a breakdown cure by scanning the API capillary. 

2. Enter a range to auto find product masses or enter up to five masses. 

3. Select either Normal (0.5 V steps) or Fast (2V step) Collection speed. 
Either is adequate for most conditions.  

4. To save the product ions to a method, select Enable, select Save, and 
choose the number of products to save. 

5. Click Browse to select the method in which to save the product ions with the 
highest intensities. 

6. Select Apply, and then Start. 
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The breakdown curves are displayed. 

To add additional ions to the method, repeat the process for the next precursor 
ion. For example, type SW 790 in the Ctrl line (or SW and whatever precursor ion 
you choose). 

For this additional precursor ion, select Auto find product masses or specify 
the product masses. 

To add ions and collision voltages to an existing method, select Append and the 
appropriate method. 
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Analog Channels 
Two analog channels can be configured in the 300 Series using Analog Out 
selections or by defining PML outputs. 

To use Analog Out, do the following: 

1. Select Analog output of from the Tools Menu. 

 

2. The Analog Out widow opens. 
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3. Connect the wires to the pins on the User I/O connector on the back of the 
instrument. For example, in the preceding screen Analog output #1, the 
signal wire, connects to pin 14 and the ground connects to pin 32. 

4. Check In Use for the appropriate channel in the Analog Out dialog. The part 
number of the user I/O Board is CUB06-0047. 

 

User I/O pins 
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Automation File Editor 

Overview 
Use the Automation File Editor to create and edit SampleLists, RecalcLists, and 
SequenceLists outside of the MS Workstation System Control application. 
Access the off-line Automation File Editor and not stop automated runs. 

NOTE: SampleLists and Sequences that are active and running in System 
Control cannot be accessed in the off-line Automation File Editor. 

Accessing the Automation File Editor 

Click the Automation File Editor button  on the Workstation Toolbar. 

Create or Edit a RecalcList 
Select a New RecalcList, or Open an existing RecalcList from the File menu. 

 

The RecalcList window opens. The RecalcList may contain autosampler and 
sample specific data handling information. The RecalcList contains the Data File 
name and data file specific data handling information. Fields, common to both the 
RecalcList and the SampleList, are described in the SampleList section. 

 
 

Recalc Notes: Enter notes about the Recalculation of the Data File. 
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AutoLink: Enter post calculation operations. 

Report: Generate a report for the selected data file. Note that if a data file is not 
highlighted in the Data File column, no report is generated. 

Actions: After generating a report using the Report button, click Actions to show 
the possible actions. 

 

Create or Edit a SampleList 
To create or edit a SampleList, do the following: 

1. From the File menu, select New to create a new SampleList or select Open 
to open an existing SampleList to edit. 
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2. Select a folder for the SampleList, type a name, and click Save. 

 
 

3. Size the Spreadsheet columns by dragging their borders with the left mouse 
button. Right-clicking a column header displays formatting options. The 
Sample Name column does not scroll.  

 

SampleList Fields  

Sample Name: Enter the sample name. Click Data Files to enter sample names. 
If only „%s‟ is listed in the Data Files, the sample name is as you entered it. 

Sample Type: Select from the menu. 

   

Cal. Level: Designate the calibration level for a Calibration sample. You can 
enter up to ten levels. 

Inj: Specify the number of injections of the sample. You may make up to nine 
replicate injections of each sample. 

Injection Notes: Enter notes about the sample. 
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AutoLink: Refer to “Inject Single Sample Menu” on page 13. 

 In the Vial, Injection Volume, and Injectors Used fields, enter the 
appropriate information.  

 The field beginning with Amt. Std. is only for data files acquired with 
standard GC detectors.  

Select the Method for the run. Click Browse to select a file. 

Other Fields 

Add: Adds a new line to the end of the list. 

Insert: Inserts a new line before the currently active line. 

Delete: Deletes the currently active line. 

Fill Down: When sections of columns or entire lines are highlighted, the 
information in the top highlighted row is repeated to the lowest selected row. 

Add Lines: Add several similar lines to the SampleList. Enter the common 
information in the dialog box. Fields in Add Lines may vary from one autosampler 
to another. Only the fields associated with the selected autosampler are 
displayed.  

 

For sequentially numbered Sample names, check the box and enter the starting 
number and the number of entries to add to the SampleList. The Sample Names 
will have these numbers appended to them. 

Defaults: Change the default entries in the table, such as Injection Volume, 
Injectors Used, etc. After defining new defaults, click Save to activate the new 
defaults. 

Data Files: Change the location and name of the Data Files. 

RecalcList: Click and generate automatically a RecalcList associated with single 
sample acquisitions. 
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Specifying the Data File Name and Path 

Data File names can be up to 256 characters long. Sample ID, injection date, 
module name, and injection number can be embedded in the file name making 
the Data File name correlate with each sample injection.  

Click Data File to open the Data Files Generation window. Select the path and 
the file name for the data file.  

 

Select the data file directory from the left side. Create a file name specification on 
the right. Combine text entry with the “%” variable symbols to specify file names 
with sample injection specific information. An example of the file name is updated 
as you enter the file name specification.  

Specifying a RecalcList 

To select the desired RecalcList option, click RecalcList. The RecalcList 
Generation window opens. You can create a new RecalcList, append to an 
existing RecalcList, or not create nor update a RecalcList. When you select 
create and update a new RecalcList, the automatically generated RecalcList 
does not overwrite an existing RecalcList. If a RecalcList with the same file name 
exists, the newly created RecalcList has a number appended to its file name to 
make it unique and to prevent the older RecalcList from being overwritten. 
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Changing Default SampleList Entries 

When you add a new row to a SampleList, default values are used for each 
entry.  

To change the default values: 

1. Click Default in the open SampleList window. 

2. Enter the desired default values and click Save. 

 

Using Several Methods for Injections 

Change the active Method from the SampleList or use a Sequence to perform 
automated injections using more than one Method. 

Changing the Method in the SampleList 

Activate a Method in a SampleList row to change the Method. 
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1. Select Activate Method from the Sample Type cell. 

2. Click AutoLink in the row that you are working. The Activate Method widow 
opens. 

3. Enter the name of the Method or click Browse to select the Method from a 
list. 

 

Create or Edit a Sequence 

To create or edit a sequence do the following: 

1. From the File menu select New and then Sequence or select Open and 
then Sequence from the File menu. 

 

3. Click Add to add lines to the SequenceList. 

4. Enter the required number of Sequence lines. 

5. Select the Action for the selected step. 

6. Click Browse to select the Method and SampleList files. 

 



 

91 

Compound Table 
Use Compound Table for automatic quantitation with external or internal 
standards. The Compound Table is part of the data handling method. In the 
Method Builder tree, click Compound Table under MS Data Handling. 

Click Show/Hide Directory to display the method full screen. 

 

 

Creating a Compound Table 

1. Click Compound Table. 

2. Click Select Data File, click the data file of your choice, and click Open File. 
This data file becomes the Reference Data File. 

3. Click Build Compound List to open the data file in MS Data Review. 

4. Click the apex of the desired peak in the chromatogram to generate a 
spectra and place information in the Spectrum List. 

5. Close MS Data Review. 

6. Click Import Compound List, and click the spectra from the table and then 
click Select. 

The compound is added to the Compound List. 

Double-clicking a cell displays more information. 
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The Compound table has the following fields; Retention time (Ret), Internal 
Standard (IS), Compound ID, Quanitation Ion (Quan Ion), Calculations, 
Integration, Identification, and Reference Spectrum (Ref Spectrum).  

 Click Select Data File to open a data file. 

 Sort, Add, Insert, Delete, Fill Down, or Restore compounds. 

 Other functions are: Build Compound List, Import Compound List, Export 
Compound List, and Print. 

 Before processing calibration files, review the compound table to check 
that the entries are correct. 

 Double-click a cell to open the Compound Tab view. In this example, 
Ret 7.316 was selected. 

Compound Attributes 

The following shows the Compound Attributes tab view after the retention time 
7.613 was double-clicked. The Chromatogram and Spectrum Displays are on top 
and the bottom part has fields. Add information, such as Compound Name and 
CAS Number, during the peak addition process. 
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Edit Name, CAS Number, Retention Time 

Edit the Compound Name and CAS fields to describe your compound. These 
entries are independent of the sample list entries. 

Click the chromatogram display to update the Retention Time. The spectrum of 
the selected scan is displayed. It becomes the new reference spectrum if you 
select it when you exit the tab dialog, or click Next, or Previous to move to a 
different entry. 

Identify Internal Standards 

By default, compounds are identified as Analytes. Identify Internal Standards by 
selecting the Internal Standard in the Compound Type section, as in previous 
screen shot. Click Next, or Previous to check the Compound ID information of 
the other analytes. If more than one internal standard is identified, select the 
internal standard for a particular target compound from the IS to Use list. 

Identify Group Members 

Sometimes target compounds are identified as a member of a group of 
compounds (for example, Trihalomethanes (THM), alkyl aromatics, etc.).  

Enter the desired name in the Group Names field. 

If more than one Group is designated in a method, select the Group Name from 
the list. 
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Quan Ions 

Click the Quan Ions tab in the Compound Table editor. When peaks are added 
to the Compound Table, the software names the Base Peak (most intense ion) 
the Quantitation Ion. The plot shows the mass chromatogram for the chosen 
Quan Ion.  

 

Edit Quan Ions 

Select a different Quan ion, a sum of ions, or a range of ions. 

 

If you selected Ion(s), Select Ions to Plot opens. Select Show Format and 
Examples to display the ways to specify ions. The Plot is redrawn automatically 
after you select the Quan Ions. You can determine if the chosen Quan ions 
integrate cleanly or if there are interferences due to co-eluting peaks or 
background contamination. 

NOTE: The Scan Function Channels field is only relevant for MS/MS or SIM 
analysis, because quantitation is done only on individual Channels of information.  
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Edit Retention Time 

To change the retention time, click the scan in the Chromatogram display. 

Look at Other Compounds 

Click Next, or Previous to see Quan Ion information for other peaks. 

Select Qualifier Ions 

Click Load to enter automatically the three most intense qualifier ion candidates 
present in the Reference Spectrum. 

 

Click Add to add the next most intense reference spectrum ion. 

The Qualifiers Table has the following fields: 

 Ion: Click in the Ion field to see the choices.  

 Ratio:  Shows the intensity of the qualifier ion as a percentage of the 
chosen Quan ion(s).  

 %Uncert.: Allowed percentage deviation from the Ratio. You can change 
the default of 20%. The % Uncertainty allowable range dependents on 
the Ion Ratio Type setting in the Calculations Setup Dialog (Absolute % 
or Relative %).  

 Low% and High%: For ion 63, the top line in the previous example and 

the allowed range for the ratio is 87.5.0  20% (absolute). Therefore 
67.5% is the Low% value and 107.5% is the High% value area.  

As samples are processed (Calibration, Analysis, or Verification runs), the 
Qualifier Ion tests are done before the peak is integrated. 
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Calculations Tab  

Click the Calculations tab to display the following. 

 

Enter Number of Calibration Levels and Amounts 

Enter the number of calibration levels, information about the calibration curve, the 
calibration amounts, and results units.  

 

The Calculations Information is updated in the Compound Table. This information 
can be automatically entered for the other compounds in the table.  

 

Click Copy Amounts to automatically enter the first value for the other levels. 
Repeat this process for all standards in the Compound Table. 

Select Curve Fit  

Select the desired curve fit from the list. 

 

For most calibration curves, use either Linear or Quadratic.  
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Security Administration 

Overview 
The Security Administration window contains three categories of security 
parameters. These features are tools for compiling with 21CFR part 11. 

 Passwords 

 Application Locking 

 File Revision Settings 

Click the Security button on the Workstation Toolbar to open the Security 
Administration window. 

 

Passwords 
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Area Description 

Password for this application Specify a password required to open the Security 
Administration application.  

NOTE: There is no way to recover this password if it is 
lost, so document the password in a secure location. 

Change Method Passwords Method passwords can be added, changed, and 
removed from the Security Administration application. 
Click Select Method to browse for and select the desired 
Method. After the Method is selected, you are prompted 
either for a new password (if no previous password 
exists for the Method), or for the old and new password 
(if the Method already contains a password).  

NOTE: that if creation of new passwords is disabled in 
the File Revision tab, you cannot add a new password 
to a Method that does not already contain one. 

Change or add Method passwords in the Method Builder 
and Interactive Graphics applications. 

Remove Method Passwords Security Administrators can remove Method passwords 
without entering the existing password. This is useful if 
the password for a Method was lost. Click Select 
Method, select the desired Method, and the password is 
removed. 

 

Application Locking 
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Area Description 

Unlocked Applications Lists the top-level windows currently running and not locked. 
Select any number of them and click Lock. 

They move to the Locked Applications list and their windows 
are disabled (they will not respond to mouse or keyboard 
input). 

Note applications locked by the Security Administration stay 
locked after the Security Administration application closes. 

Locked Applications Lists the top-level windows currently running and locked. 
Select any number of them and click Unlock. They move to 
the Unlocked Applications list and their windows are enabled 
(they respond to mouse or keyboard input). 

File Revision Settings 

 

 

Area Description 

Require Revision Log entry 
when changes to Methods 
are saved. 

When checked, prompts you for a description of 
changes when a Method file is altered and saved.  

The Revision Log appears: 

 Listed in the Notes of the File Open dialog box. 

 Listed in the Method Builder application window 
when the Method is open. 

 Included in the Method printout. 

Update Revision Log in Data 
Files with Recalculation date, 
time, and Method name. 

Data Files are updated with a time stamp and Method 
name when they are recalculated (either from System 
Control or from Interactive Graphics).  

The Log can be included in printed reports. 
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Area Description 

Enable results deletion from 
"Open Data File" dialog 
boxes. 

A button appears in the Open Data File dialog allowing 
results to be deleted from a specified channel of a Data 
File.  

Results deletions are logged in the Data File's Revision 
Log.  

This option only affects standard GC results. GC/MS 
results will not be deleted. 

Disable creation of new 
passwords in Method files. 

When checked, new passwords cannot be added to 
Methods.  

Methods with passwords prompt users for their 
password before saving changes. 
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PML 

Overview of PML 
The procedures that generate information reporting results from the mass 
spectrometer are written in a language called Paw Macro Language (PML). It has 
commands that control the instrument or data processing. Users can write 
procedures to customize data processing. 

Simple Commands 
Enter simple commands in the Ctrl field, bottom left. 

 

 

 

Typing “Hello” (quotes included) in the CTRL text box prints Hello in the Out 
Status display on the task bar.  

CANCEL stops the Paw macro running at the top level. 

QUIT stops all paw macros. If you use the Quit key word, type scan to restart the 
system. 
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PML Syntax 
The macros are text files with the extension.pml. There are macros in the PML 
Directory (default: C:\VarianWS\1200sys\PML). If you create your own macros or 
make new versions of the existing ones, store them in the User PML Directory 
(default: C:\VarianWS\UserPML). Macros can be edited using the Pml Editor 
described later in this section.  

The names can contain letters, numbers, or underlines, but they must begin with 
a letter. 

Run a macro by typing the name of the command lines of the instrument window 
(CTRL) or including the name in another macro. You can send arguments to a 
macro and it will return a value. 
 

Paw Macros Consist of 
Statements: 

Examples: 

Action or function keywords: OFF 
DOZE(2.5) 

Macro calls: CGON 
SW(219) 

Assignment statements:  DETECTOR = 1000 
DETECTOR += 50 
DETECTOR -= 50 
x = COS(PI) 

Conditional Statements:  IF (WIDTH > 10) 
ELSE 
WHILE (x < 100 & y <= 100) 
UNTIL (x = 100 | y != 100) 
REPEAT 100 
REPEAT 

Completing Statements: END 
terminates a conditional statement 

 RETURN(n) 
returns from a subroutine with result n 

 CANCEL 
stops the paw macro running "at the top level" 

 QUIT 
stops all paw macros 

Printing statements: ?DETECTOR 
prints the current detector value on the display. 

 "Hello" 
prints Hello on the display. 
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The Statements Refer To: 

numerical values e.g. 20, -3.5, 1000H 

variable keywords e.g. DETECTOR 

function keywords e.g. COS 

action keywords e.g. FISH 

macros e.g. STANDBY 

user variables e.g. X,Y 

arguments e.g. %1,%2,%3,%4,%5 

   

Notes 

1. Statements are separated from each other by colons, semicolons, or line 
breaks. 

2. Conditional statements must have a matching END statement: 

 if (x < y) & ~(x = 2) : fish : else : scanlens : end 

 if x = 3 : sw(502) : end 

 i = 1 : repeat 100 : sn = i: list(i) = tic : i + = 1 : end 
 

END statements at the bottom of a PAW Macro can be deleted. 

3. Printing statements (using ? and "") can be strung together. They are 
terminated with the keyword CR (carriage return). 

4. Some keywords create text like the printing statements using ? and ".” 

GET_FILENAME 

LIB_FORMULA 

LIB_NAME 

LIST_TO_STRING 

SAMPLE_NAME 

STRING_RESTORE 

SUB_FILE_NAME 

VERSION 

5. Some keywords re-route the text created by printing statements  
(using ? and ") to other places than the display. 

DACS_RESTORE : "file name” : CR 

DACS_SAVE : "file name” : CR 

FILE_APPEND : "file name” : CR 

FILENAME : "file name” : CR 

FILE_OPEN : "file name” : CR 

IONS_RESTORE : "file name” : CR 

IONS_SAVE : "file name” : CR 

LCD : "message” : CR 

LIB_FIND : "compound name” : CR 
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LIST_RESTORE : "file name” : CR 

LIST_SAVE : "file name” : CR 

MSGBOX : "label text” : CR : "default”: CR: 

 "Macro”: CR 

PICT_LABEL : "label text” : CR 

PICT_TITLE : "title text” : CR 

STRING_SAVE : "text" : CR (ten user strings) 

STRING_TO_LIST : "text" : CR 

SUB_NAME : "text" : CR 
 

6. Statements may include comments. A # ends the statement and starts the 
comment, e.g., :DETECTOR += 10 # raise the detector to make the peak 
bigger. 

7. All numerical values referred to in PAW Macros are real numbers. Usual 
algebraic syntax is allowed:, e.g., x = (sin(y) + cos(sqrt(detector))) / (30 * 
month + day). 

8. When parameters are passed to macros, they are referred to within the 
macro as %1, %2, %3, %4 and %5. e.g., if the macro TIMES is defined as 
?%1 : "times" : ?%2 : "equals" : ?(%1 * %2) : CR and you type "TIMES 7 9" 
and the instrument will print out "7 times 9 equals 63". NOTE: %1 - %5 can 
be used as local variables within any macro. 

9. When passing parameters to a macro or keyword, you can leave out 
parentheses at the top level. 

10. All these are valid statements: 

FISH(3) 

FISH 3 

FISH 3 2 

FISH 3,2 

FISH(3,2) 

When assigning a value to a variable or parameter you can leave out the 
= sign. 

DETECTOR = 1000 

DETECTOR 1000 

but:  "lens(1) = 100" is ok while "lens 1 100" is ambiguous. 

11. When using printing statements on the control line, or if the string you type 
starts with? or " or VERSION, you don‟t have to type the terminating CR. 
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System Paw Macros 
1. When the Status Window is opened, a Ctrl: PML (default: INIT) and a Proc: 

PML (default: QUAN_INIT) are both run. 

2. In the Collect menu (toolbar start button) a Ctrl: PML is defined which runs 
when the file being collected is opened. 

3. In the queue menu (Collect Queue edit button) a Proc: PML is defined which 
runs when the file being collected is closed. 

4. A Windows application outside the instrument can request a PML through the 
windows DDE mechanism. 

5. Using the MSGBOX keyword you create and run PMLs. 

6. Some PMLs run when you click on buttons or menu items: 

File menu Reset:  INIT 

File menu Standby:  STANDBY 

Status control menu:  CGON CGOFF CION CIOFF CIDON CIDOFF 

AutoTune menu:   ATUNE1 ATUNE2 ATUNE3 ATUNE4 ATUNE5 ATUNE6 

Diagnostic menu:  DIAGNOSTIC(test_number) 

Tune Table menu optimize button:  OPTIMIZE 

Status probe button:  PROBE_MAIN 

Species Boiling Pt. Range menu compute button: SHELL 

Clicking in Chro:  CHRO_CLICK(sn,rt,type_rt + (10*type_sn) + 
(1000*make_substance)) 

(click on the CHRO scales button to see where type_rt,type_sn, and 
make_substance are defined) 
 

Other popular PMLs are: 
BL PAR 
DAU QIMS 
FM Q3MS 
LM SCAN 
MIXED SW 
NL 
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Help Files for PML 
Click Help in the System Control window to open the Paw Guide. 
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Some PML Procedures 
The Cioff.pml macro closes the CI gas valve, prints “Evacuating CI Gas (takes 5 
seconds)” in the status area of the taskbar, opens and closes the vent valve, and 
prints “CI gas off” in the status area of the taskbar. 

CIOFF.pml 

valve 2 = 0 # close CI valve 

"Evacuating CI Gas 
(takes 5 seconds)";cr 

#printing statement, terminated with the keyword CR 
(carriage return) 

doze 1 #wait one second 

valve 4 = 1 # open CI vent valve for 0.2 seconds 

doze .2  

valve 4 = 0 # close vent valve for one second 

doze 1  

valve 4 = 1 # open vent for 3 seconds 

doze 3  

valve 4 = 0 # finally close vent 

"CI Gas off!";cr #printing statement, terminated with the keyword CR 
(carriage return) 

The LEAK.pml assists in finding vacuum system leaks. It sets a series of masses 
from a compound or mixture used for leak detection. First. the Pict view window 
is cleared, the title in the Pict window is set, centroid mode is set, mass range is 
set, the parameters are optimized to prevent saturation, and a series of mass 
intensities are plotted while the user sprays a gas at possible leak locations. 

LEAK.pml 

pict_clear # clear the picture/graph window 

pict_title:"1->mass 18,  
2->mass 28, 3->mass 
33, 4->mass 45, 5-
>tic":cr 

#Sets the title in the pict view 

cent #Go to centroid mode 

fm 10 #Set first mass (FM) to 10 

lm 50 #Set last mass (LM) to 50 

optdet #Optdet runs opt_detector.pml to prevent detector 
saturation after each scan. 

repeat #repeat items below 

fish #go get one scan of data 

pict(,area(18),1) #get area of mass 18 and plot point in pict view position 1 

pict(,area(28),2) #get area of mass 28 and plot point in pict view position 2 

pict(,area(33),3) #get area of mass 33 and plot point in pict view position 3 

pict(,area(45),4) #get area of mass 45 and plot point in pict view position 4 

pict(,tic,5) #get area of mass total ion current (tic) and plot point in pict 
view position 5 

end  

Mixed.pml gets one scan in centroid data and one scan of profile data. 
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MIXED.pml. When Prof and Cent views are selected in the window, both real 
time centroid and Profile data is observed. 
 

Repeat #repeat items below 

Prof #set to scan of profile data 

Fish #go get one scan of data 

Cent #set to scan of centroid data 

Fish #go get one scan of data 

End  

 

PML Editor 
The PML Editor is used for creating and editing PMLs for the 300 Series 
software. The PML Editor allows access to the factory PML files; however, if a 
factory PML is modified it will then be saved as a user PML in the UserPML 
directory. 

Accessing the PML Editor 

Click Tools in the Quad module window to display the PML editor.  
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The PML editor window opens.  

 

 Varian PMLs are stored in c:\varianws\1200sys\PML directory. 

 User created PMLs or modified factory PMLs are stored in 
c:\varianws\UserPML directory. 

 The Status Bar of the PML Editor displays the line number of the current 
cursor position. 

 

Selected line number 

 

 The Tool menu has three menu items: 

Version History: If the 21CFR11 application is enabled, click this to display the 
version history of the currently open PML. 
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PML Info: Display the PML path name, release version number, and any 
descriptions that have been in the PML header section. (Lines begin with ##). 

 

PML Utility: Perform syntax checking of the currently open PML and produce a 
call tree, PML keywords and User Variables defined in the PMLs. For the 
keywords listed, user can select and use F1 to get online help about the 
keywords. 

In the right part of the utility dialog box, enter a specified keyword, and find out 
the PMLs contain this keyword. 
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